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1 INTRODUCTION  

1.1 OVERVIEW 

DeskTop Gas is an interactive gas property calculator that provides thermodynamic and 
transport properties for mixtures of moist gases.  The current library includes the following 
gases: nitrogen (N2), oxygen (O2), argon (Ar), carbon dioxide (CO2), and water vapor (H2O).  
The thermodynamic property functions are calculated for mixtures of all five gases using an 
accurate third order virial equation of state.  See the theory and accuracy section for an 
explanation of how Techware developed the equation of state. 

These five gases account for 99.997% of the volumetric composition of standard air and also 
account for better than 99.9% of most combustion gases. 

The functions are valid over a temperature range from 180 °K, (-136 °F) to 2000 °K, (3140 °F) 
and at pressures up to 50 bar (725 psia). 

DeskTop Gas can be used to calculate the thermodynamic and transport properties of moist 
air by using the composition of standard air.  In some cases, when dealing with psychrometric 
properties of air such as relative humidity, wet bulb temperature or degree of saturation, it may 
be more convenient to use Techware’s DeskTop Air add-in which includes properties to handle 
these parameters.  The two packages use similar equations except that the DeskTop Air 
program mixes two gases (dry air plus moisture) while the DeskTop Gas product mixes five 
discrete gases.  Nonetheless, the values returned by DeskTop Gas when using a mixture 
composition corresponding to standard dry air agree quite well with those returned by the 
DeskTop Air.   

1.2 32-BIT AND 64-BIT VERSIONS 

The DeskTop Gas package includes both 32-bit and 64-bit installation files.  If you are running 
a 64-bit operating system, such as Windows 7, you should install the 64-bit version; otherwise 
you should install the 32-bit version.  They are functionally identical. 
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2 USING DESKTOP GAS CALCULATOR 

2.1 OVERVIEW 

DeskTop Gas is a Windows application, which calculates the thermodynamic and transport 
properties of a mixture of moist gases.   It can be used as an interactive replacement for gas 
property tables but does much more than that.  It automatically calculates all unknown 
properties when a state point is defined by known properties.  The program is flexible, and 
designed to minimize keystrokes for common calculations.  DeskTop Gas allows you to enter 
any number of state points, label them and store the collection of points for later reference.  
You can print a table of stored points or copy them to the clipboard and paste them into your 
favorite spreadsheet or word processor. 

Major features of this program include: 
o validity over a wide range of pressures and temperatures 
o flexible interactive design 
o large choice of units for each property 
o tools for heating, cooling, expansion and compression processes 
o instant response time 
o extensive help screens 

 
If installed properly, DeskTop Gas is started by simply double clicking on its name/icon in the 
DeskTop Gas subgroup of the TechwareEng Group appearing on the Windows Start Menu. 

 

2.2 BASIC OPERATION 

The DeskTop Gas display is arranged in a tabular format that remains constant although the 
program window can be re-sized.  You may sometimes find it convenient to make the program 
window smaller.  Each of the rows in the top section is dedicated to one of the gas properties 
(pressure, temperature, specific volume, enthalpy, entropy, specific heat, dynamic viscosity, 
thermal conductivity and dew point temperature.  Each of the rows in the “Gas Composition” 
section shows the fraction of one of the individual gasses as well as the humidity ratio and 
molecular weight of the mixture.   There is a column that displays the property values for the 
active point and a column that displays data for one of the stored points. 

The key properties that can be used to define the gas state point are: pressure, temperature, 
specific volume, enthalpy, entropy, and the gas composition.  Theoretically, a state point can 
be uniquely identified by specifying the gas composition and any two of the other five 
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properties.  In most practical applications, pressure is usually one of the known variables.  
Most of the calculations require that the pressure be known.  In the rare case when pressure is 
not known, it can be calculated from the equation of state if the dry bulb temperature and 
specific volume are known.  

Each of the key properties has a check box associated with it.  When checked, it signifies that 
this property is to be used in calculating the state point.  In general, two thermodynamic 
properties and the gas composition must be selected before DeskTop Gas will allow a 
computation.  If pressure and temperature are selected, DeskTop Gas can compute the gas 
properties in the state that is saturated with water vapor.  In these cases, you will notice that 
the ‘Compute Saturated’ button is enabled.  Once you select one property, DeskTop Gas will 
disable all the other check boxes whose properties are not allowed in combination with the first 
selected property.  You may change your selections by un-checking one or all of the check 
boxes and selecting a new combination. 

To compute a gas property state point, begin by entering the gas composition in the lower half 
of the calculator.  If you wish to use the composition for standard dry air, press the button 
labeled “Set to Standard Dry Air”.  Note the label in the units column next to each gas 
component.  It indicates the basis of the gas composition.  Initially, the label should indicate 
“Vol frac Dry”, which means that the gas composition is entered as a volume or mole fraction 
on a dry basis.  Note that the value for water vapor is zero and the box is read only.  This 
ensures that you can only enter water vapor as a humidity ratio.  If you want to enter the 
composition on a wet basis, press the button labeled “Change to Wet Composition”.  Now you 
will find that the humidity ratio is read only and water vapor box is enabled.  If you want to 
enter the composition as mass fractions instead of mole fractions, press the button labeled 
“Change to Mass Fraction”.  The other button in the gas composition section resets the gas 
composition to all zeros. 

All mass-dependent properties (specific volume, enthalpy, entropy, specific heat and viscosity) 
can be expressed on either a dry or wet basis.  The default for DeskTop Gas expresses the 
properties per mass of dry air.  This is consistent with ASHRAE conventions and is quite useful 
when dealing with processes that involve evaporation or condensation of water vapor. If you 
want the mass-dependent properties to be expressed on a wet basis instead of a dry basis, 
press the button labeled “Change to per Wet Mass”. 

Next, select the input properties by selecting the corresponding check boxes as described 
above.  Enter values for those properties in the boxes to the right of the property names.  (The 
next section describes various methods for entering data.)  When you enter a value for any of 
the key properties, a red “X” appears next to the property value to indicate that a new value 
has been entered.  This is a warning that the value being displayed is not consistent with the 
current state point.  After a compute command is completed successfully, all property values 
are recalculated and the red “X’s” are cleared. 

Be sure to enter the values in units consistent with the unit displayed to the right of the value 
box.  If you wish to change units, select the desired units before entering the value.  If you 
change units after the value is entered, the value entered will be converted to the new units.   
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Next, click the 'Compute' button to find all the unknown properties. If the ‘Compute’ button is 
grayed, you have not checked enough properties to define the state point.  Fields without 
check boxes are output only.  These include specific heat, viscosity and thermal conductivity 
and dew point.  After recalculation, all fields contain property values for the gas mixture at a 
particular state point. 

2.2.1 Reference Conditions 
Enthalpy and entropy values are always expressed relative to particular reference conditions.   
Many people forget that the values of enthalpy and entropy that are found in published tables 
are not absolute values but instead, are relative to particular reference conditions.  Engineering 
calculations always deal with enthalpy or entropy differences, typically between in-flowing and 
out-flowing streams.  For this reason, it does not matter what you select as the reference 
conditions, as long as you use them consistently.  DeskTop Gas allows you to select reference 
conditions consistent with ASHRAE or an alternate set of conditions based on absolute zero 
temperature.   

In SI units, ASHRAE uses a reference condition of 0 °C and one atmosphere of pressure for 
dry air.  For water vapor, ASHRAE used a reference condition of liquid water at the triple point 
temperature of 0.01 °C.  In English units, however, ASHRAE uses a reference condition of 0 °F 
at one atmosphere of pressure for dry air properties while maintaining the convention of using 
the triple point as a reference temperature for water properties.  DeskTop Gas allows you to 
set the reference temperature of 0 °F, 0 °C or 0 °K. 

Please note that in all cases, the enthalpy and entropy of the water portion are set to zero for 
liquid water at the triple point.   Some publications, which are based on perfect gas 
assumptions, assign the zero point for enthalpy and entropy to water in the vapor state at the 
triple point or some other specified temperature.  We believe that setting the zero point for 
enthalpy and entropy to water in the liquid state rather than in the vapor state has two major 
advantages.  First, the values are numerically equivalent to standard international steam tables 
(and Techware’s WinSteam product).  This facilitates the handling of processes that include 
both moist gas and liquid water streams without worrying about reference temperatures.  
Second, It greatly simplifies analysis of processes in which water is either condensed from or 
evaporated to the gas stream. 

All of DeskTop Gas’ reference conditions use the International Temperature Scale of 1990 
(ITS-90) as the basis of temperature. 

2.3 ENTERING DATA 

Numeric data is entered in a specially designed edit box called an IO Box, which behaves like 
a standard Windows edit box but includes some additional features.  To enter new data, 
double click the IO Box and all the data will be highlighted.  As you enter new data, the old 
data will be replaced.  To edit data, hold the left mouse button down and drag the mouse over 
the characters that you wish to replace, thereby highlighting them.  Release the mouse button 
and type new characters to replace the highlighted ones. 
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The IO Box has two modes of operation, input and output.  When new data is entered, the IO 
Box is placed in the input mode and a red X appears to the left of the box.  After a new state 
point is computed, all IO Boxes are placed in the output mode and the red X’s are removed. 

The IO Box accepts either numerical values or arithmetic expressions that can be evaluated to 
a numeric value.  A number can be entered in either decimal or scientific notation.  The 
expression can be any valid arithmetic expression using the following operators: 

+  add 
- subtract 
* multiply 
/ divide 
^ exponent 
( ) parentheses 

Arithmetic calculations can be nested to any level using parentheses. An example of a valid 
expression is: 

((1004^2 + 997^2) / 2)^.5 

which evaluates to 1000.506. 

Expressions are evaluated whenever you tab to or click on another control or press the ‘Enter’ 
button.  Only the resulting value is shown in the box.  If you enter an incorrect expression, your 
computer will beep and the edit cursor will highlight the offending character.  You must fix the 
error before DeskTop Gas will allow you to continue. 

If the expression you are entering is too long to fit in the box, the box will temporarily increase 
in length so that you may view more of the expression.  When you are finished editing, the box 
returns to its original length. 

To recall the last expression used in an input box, use the 'Recall Expression' command on the 
'Edit' menu.  You’ll then have the opportunity to edit the expression and let the IO Box re-
evaluate it.  Note that the box retains the last number or expression entered even after a 
compute command is issued.  As a result, the value in the box will not reflect the value of the 
recalled expression if a compute command has altered the value. 

You may use the ‘Cut’, 'Copy' and 'Paste' commands on the 'Edit' menu or the toolbar to 
exchange numeric data between DeskTop Gas’ IO Boxes and any other application that 
supports the clipboard.  If you start entering data in an IO Box and wish to go back to the 
original data you may use the 'Undo' command on the 'Edit' menu.  However, once the IO Box 
loses the focus, the 'Undo' command is no longer available. 

2.4 UNIT SELECTION 

DeskTop Gas allows you to use any combination of units for input and output properties.  The 
units for each property can be set independently by using its associated combo box. To 
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change a unit, select its combo box and scroll through the list of available units using either the 
keyboard cursor arrows or the mouse.  Whenever a new unit is selected, the program converts 
the values displayed for that property to the new units.  Therefore, when entering data you 
should first select the units and then key in the input values.  Otherwise, the values will be 
converted to the new units and you will have to re-enter them. 

The first time the program is started, the properties will be displayed in SI units.   You can 
change all of the units to either standard English or SI units by issuing the 'English Units' or 'SI 
Units' command from the 'Format' menu or pressing the ‘Eng’ or ‘SI’ toolbar button.  When you 
change to English units in this manner, the reference temperature for the dry gas is changed to 
0 °F.  Similarly, when changing to SI units, the reference temperature is changed to 0 °C. 

If you change the units one at a time, the reference temperature will not change, even if you 
change all of the units from English to SI units.  You can force a change in the reference 
temperature by pressing the ‘Ref’ button on the toolbar or by selecting ‘Options’ from the 
‘Tools’ menu and then choosing the ‘Reference Point’ tab.  From either of the dialog boxes, 
you will be able to select the desired reference temperature. 

You may choose any combination of available units for your personal default unit set.  Simply 
select the units you desire for each property and issue the 'Make Current Settings Default' 
command from the 'Format' menu.  The next time you start DeskTop Gas, your default unit set 
will be used. 

If you change units and then save a file, those selected units will be restored whenever the file 
is opened.  If you wish to change the units back to your default unit set, issue the command 
'Restore Default Settings' from the 'Format' menu. 

2.5 CALCULATING STATE POINTS 

When you have finished entering values for the selected input variables, click the on-screen 
button labeled 'Compute' to calculate all of the state point properties.  If the 'Compute' button is 
grayed, you have not checked enough properties to define the state point.   

You may also compute the state point by pressing the 'Enter' key on your keyboard.  Note that 
the 'Enter' key serves two purposes in DeskTop Gas.  Pressing the 'Enter' key just after 
entering data in an IO Box, tells DeskTop Gas to evaluate the expression in the IO Box.  
Pressing the 'Enter' key a second time tells DeskTop Gas to compute the state point.  If you 
move the focus to any other control after entering data in an IO Box, the expression is 
evaluated automatically and you only have to press the 'Enter' key only once to compute the 
state point.   The ‘Enter’ key will not compute a state point if the ‘Compute’ button is grayed. 

2.6 FORMATTING PROPERTY VALUES 

DeskTop Gas normally displays all property values in fixed decimal notation.  You may 
increase or decrease the number of decimal places in a selected property IO Box by selecting 
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‘Add Decimal Places’ or ‘Decrease Decimal Places’ from the ‘Format’ menu or by clicking 

either of the  toolbar buttons, respectively.   

If you wish to change the selected property to scientific notation, select the 'Scientific Notation' 
command from the ‘Format' menu or press the ‘EE’ toolbar button.  The ‘Format’ menu many 
be used to change the number format to 'Fixed Decimal' or 'Percent' as well.  Corresponding 
toolbar buttons are ‘Fix’ and ‘%’ respectively. Of course, the percent format only makes sense 
for the non-dimensional properties. 

The formatting commands are only enabled when the focus is on an IO Box. 

2.7 LABELING AND STORING STATE POINTS 

DeskTop Gas gives you the option of labeling and storing any number of state points for future 
reference.  After computing the state point, DeskTop Gas will automatically suggest a unique 
name for the new state point such as “Point 1” or “Point 2”, but you will probably want to enter 
something more descriptive.   Just enter a new name in the Point Label box.   

To store this point, press the 'Store Point' button. (The Store button will not be enabled if the 
displayed data is not a correctly calculated state point.) DeskTop Gas requires all stored points 
to have a unique label.  If you try to store two points with the same label, DeskTop Gas will 
query whether you wish to replace the stored point, which has the same label, with the current 
point.  If not, you should rename the point and try to store it again.   

After storing the point, the state point values for the active point will be copied into a storage 
array and given the name you selected.  The point will be displayed in the stored points 
column in same units as the active point.  After a state point is stored, its name is added to the 
point name combo box in the upper right hand corner of the main window. You can view a 
stored point by pressing the arrow on the point name combo box and selecting a point from the 
drop down list.  

If you wish to use a stored point with any of the special tools or as the basis for calculating a 
new point, you must recall the stored point to the active point.  Begin by selecting the point 
from the point name combo box’s dropdown list.  Next, press the ‘Recall Point’ button to copy 
the stored point to the active point.  You may now use the active point for new calculations.  If 
you change any input data and press 'Compute', the active point will be changed but the stored 
point from which you copied the values will remain intact.   

You can delete a stored point by first selecting it from the Point Name combo box and then 
select 'Delete Point' from the 'Edit' menu. 

This collection of state points can be saved as a DeskTop Gas file.  In addition, you can copy 
state points to the clipboard, where they can be transferred to another application such as a 
spreadsheet program or word processor. 
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2.8 PRINTING  

You can print a table consisting of all of the stored points by selecting the Print command from 
either the file menu or the toolbar.  The tables will include a column for each of the stored 
points with each of its properties listed in a row.  A label for each row includes the property 
name and the current units selected.  The printing utility will attempt to fit as many points on a 
page as possible, based on the paper size and orientation that you specify using the ‘Print 
Setup’ command.  You can preview the output by selecting the ‘Print Preview’ command from 
the ‘File’ menu. 

2.9 SAVING AND OPENING DATA FILES 

When you start DeskTop Gas or open a new file, it will be untitled.  You may save a collection 
of stored state points along with your selections of units and formats to a DeskTop Gas file.  
Select 'Save' from the 'File' menu or click the disk icon on the toolbar, which will open the 
“Save As” dialog box.  You should enter a name for the file; the file extension “.gas” will be 
added automatically.  You may choose a folder in which to save the file or accept the default 
folder. 

If you have saved the file at least one time during the session, you can save the work under a 
different filename by choosing the ‘Save As’ command from the ‘File’ menu. 

To open a saved file, select 'Open' from the 'File' menu or click the open file icon on the 
toolbar.  This will open a dialog box that lists all of your DeskTop Gas data files in the current 
folder.  You may select a different folder to view other files.  Select the file you want to open 
and press the ‘Open’ button to load the file. 

To start a new file, select the 'New' button from the Toolbar.  If you have stored any points and 
have not saved the file, you will be prompted to do so. 

2.10 ADVANCED FEATURES 

DeskTop Gas includes special tools that facilitate the calculation of some common gas 
processes.  These tools include an Expansion/Compression tool and a Heating/Cooling tool. 

2.10.1 Expansion/Compression Tool 
The Expansion/Compression tool is used to evaluate performance of a gas turbine or an gas 
compressor.  If you are predicting the performance and know the efficiency of the turbine or 
compressor, the tool can be used to calculate the state point conditions at the expansion or 
compression end point.  If you are analyzing the performance of a turbine or compressor and 
know the conditions at the end point, the tool can be used to calculate the efficiency.  The tool 
also computes the energy converted to shaft work generated by the turbine or used by the 
compressor. 
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To use the tool, first select the active state point representing the start of the expansion or 
compression path.  Next, select 'Expand/Compress' from the 'Tools' menu or click the turbine 
icon on the toolbar, which will open the Expansion/Compression tool dialog box.   

In the tool dialog box, select the conditions you will use to compute the end point from the 
combo box near the top of the screen.  Select “Pressure & Efficiency” if you know the pressure 
and efficiency.  If you are checking an actual machine you will need to know the exiting gas 
temperature or enthalpy.  Check either the “Pressure, Enthalpy” or Pressure, Temperature” 
buttons as required.  The two variables you have chosen will have their value fields enabled; 
all others will be grayed.  Enter the appropriate values and click the 'Compute' button. 

The “Gas Flow In” column displays the state point properties entering the equipment, which 
were copied from the active point.  The “Total Flow Out” box has three columns that display 
the state point properties at the end of the expansion.  The first column identifies the 
thermodynamic properties for the moist gas mixture and liquid water (if any) exiting the 
equipment.  The second column displays the thermodynamic properties for the moist gas 
exiting and the third column shows the properties for the liquid water if any condensation 
occurs. The units displayed are those currently in use on DeskTop Gas’ main window.  If you 
wish to use different units, you should select those units on the main window before opening 
the expansion tool. 

Below the state point properties, you will find the shaft power based on the entering gas flow 
rate that you entered.  The units for these results will be consistent with your input units.  

You may change any of the data and repeat the calculation as required.  When you are 
satisfied with the result, you may copy that state point back to the active point on DeskTop 
Gas’ main window by pressing the 'Close and Copy to Current Point' button.  Note that the 
values of moist gas in the second column will be copied back to the active point.  If no 
condensation has occurred, these values will be the same as in the first column labeled 
mixture.  If condensation has occurred, then the values in the second column will be at 
saturated conditions.   

If you do not wish to replace the current point on the main window with the expansion end 
point calculated, just press the 'Cancel' button. 

2.10.2 Heating/Cooling Tool 
The Heating/Cooling tool is used to analyze a gas stream in which heat is either added or 
removed.  If you know the quantity of heat that is being added to or removed from the gas 
stream, you can use the tool to calculate the resulting state point temperature and other 
conditions.  If you know the temperature or enthalpy of the gas leaving the heating or cooling 
device, you can use the tool to calculate the quantity of heat exchanged.   

To use the tool, first make sure that the active state point represents the conditions of the gas 
entering the heating or cooling device.  Next, select 'Heat/Cool' from the 'Tools' menu or click 
the flame icon on the toolbar, which will open the Heating/Cooling tool dialog box.   
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In the tool dialog box, select the conditions you will use to compute the end point from the 
combo box near the top of the screen.  Select “Pressure, Heat Flow” if you know the pressure 
and heat added or removed.  If you are measuring performance on an existing device you will 
need to know the exiting gas temperature or enthalpy.  Check either of the “Pressure, 
Enthalpy” or “Pressure, Temperature” buttons as required.  The two variables you have chosen 
will have their value fields enabled; all others will be grayed.  Enter the appropriate values and 
click the 'Compute' button. 

The “Gas Flow In” column displays the state point properties entering the equipment, which 
were copied from the Active Point in the main screen window.  The “Total Flow Out” box has 
three columns that display the state point properties at the end of the expansion.  The first 
column identifies the thermodynamic properties for the mixture of moist gas and liquid water 
exiting the equipment.  The second column displays the thermodynamic properties for the 
moist gas exiting and the third column shows the properties for the liquid water if any 
condensation occurs. The units displayed are those currently in use on DeskTop Gas’s main 
window.  If you wish to use different units, you should select those units on the main window 
before opening the Heating/Cooling tool. 

Below the state point properties, you will find the heat added based on the entering gas flow 
rate that you entered.  The units for these results will be consistent with your input units.  

You may change any of the data and repeat the calculation as required.  When you are 
satisfied with the result, you may copy that state point back to the Active Point on DeskTop 
Gas’ main window by pressing the 'Close and Copy to Current Point' button.  Note that the 
values for moist gas in the second column will be copied back to the active point.  If no 
condensation has occurred, these values will be the same as in the first column labeled 
mixture.  If condensation has occurred, then the values in the second column will be at 
saturated conditions.   

If you do not wish to replace the Active Point on the main window with the heating/cooling state 
point calculated, just press the 'Cancel' button. 

2.10.3 Exchanging Data with Other Programs 
DeskTop Gas includes two ways to share data with other applications running on your PC 
such as Excel.  Both methods use the Windows clipboard.   

In the first data sharing method, DeskTop Gas' 'Edit / Copy' command copies whatever text is 
highlighted in an IO Box (e.g., a number or part of a number) to the Windows clipboard.  From 
there, that text can be pasted into other applications running on your PC.  This is typically done 
using those applications’ 'Edit / Paste' command). 

The second data sharing method also places text on the clipboard but uses an extended 
format that is especially useful for calculations involving gas properties.  This method is 
accessed using the 'Copy Point' command on the 'Edit' menu.  Regardless of whether any text 
is selected, this command copies a table of text values to the clipboard using either the Active 
Point or all of the stored points.  The table includes one column for each point. You can 
optionally direct DeskTop Gas to also include property and unit labels in which case they 
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appear as the first column in the table.  The table includes one row for each property in the 
same order as they are displayed on DeskTop Gas’ main window.  All values are copied to the 
clipboard using the same format displayed on the screen.  So, if you need more accuracy in 
your Excel calculations, set the DeskTop Gas display accuracy accordingly, before issuing the 
'Copy Point' command. 

2.11 GETTING HELP 

The Help menu offers extensive on-line help for DeskTop Gas.  The 'About' item in the Help 
menu presents the version and serial numbers of your copy of @Gas.  If the program is 
running in its Demo mode, the number of days remaining on the Demo are displayed instead 
of a serial number. 

2.12 ERROR MESSAGES 

When input values are out of range or any other errors occur, a message box is displayed 
describing the error.  The calculated fields will not be updated until the error condition is 
resolved. 

2.13 EXITING DESKTOP GAS 

You may exit DeskTop Gas by using any of the standard methods for closing Windows 
applications.  These include the following: 

• Click the upper left corner of its program window and select close from the menu. 

• Select Exit from the File menu. 

• Press Alt + F4 keys. 

• Click the “X” button in the upper right corner of the program window.
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3 THEORETICAL BASIS OF @GAS FUNCTIONS 

It is commonly accepted that virial equations of state work well for gases.  In @Gas, the P-V-T 
behavior of a gas mixture is described by a third order virial equation of state: 
 

 L+++= 21
v
C

v
B

RT
pv mm

 

where, 
 p  = Total pressure 

 T  = Absolute Thermodynamic Temperature 
  = Total volume of gas v

 R  = Universal Gas Constant 
Bm = second order virial coefficient of the mixture 

  = third order virial coefficient of the mixture Cm

For the ranges of pressure and temperature used in these functions, coefficients higher than 
third order can be ignored.  It is important to note that Bm and Cm are functions only of 
temperature.   
 
Over the range of temperatures and pressures covered by these functions, all of the gases 
except water exist only in the gaseous state.  (Actually, CO2 can exist in a liquid state at the 
high end of the pressure range and the low end of the temperature range but this state is not 
considered because it would only occur in a mixture that is almost pure CO2.)  At temperatures 
where the saturation pressure of pure water is greater than the total gas pressure, the mole 
fraction of water vapor can range from 0 to 1.  That is, there is no limit to the percentage of 
water vapor in the gas mixture in that situation.  Elsewhere, the mole fraction of water vapor 
can range from 0 to a limiting, saturated, value xeq, which is reached when the condensed 
phase of water is in thermodynamic equilibrium with the gas solution.  This equilibrium fraction 
is equivalent to the solubility of the condensed water in the solvent gas mixture.  In order to 
facilitate calculation of xeq it is convenient to group the virial coefficients of the non-water gases 
so that the mixture can be treated as a binary mixture between the non-water gases and water 
vapor. 
 
The virial coefficients of the gas mixture can be expressed as: 
 
   B x B x x B x Bm g gg g w gw w w= + +2 22 w

and 
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  C x C x x C x x C x Cm g ggg g w ggw g w gww w www= + + +3 2 2 33 3

where, 

  = mole fraction of the non-water gases in mixture xg

  = mole fraction of water vapor in the mixture xw

  = virial coefficients of the non-water gases B Cgg ggg,

  = virial coefficients of water vapor wwwww CB ,

  = cross virial coefficients  B C Cgw ggw gww, ,

Since the sum of the mole fractions of the mixture must equal 1, the value xg is equal to 1 - xw.  
The second virial coefficient of the non-water gases can be expressed as: 
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and the second cross virial coefficient of the mixture can be expressed as: 

[ ] ( )B B x B x B x B x xgw NW N OW O AW A CW C W= + + + −/ 1  

Similarly, the third virial coefficients can be expressed as: 
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and  

[ ] ( )C C x C x C x C x xgww NWW N OWW O AWW A CWW C W= + + + −/ 1  

where the subscripts N, O, A and C refer to N2, O2, Ar and CO2 respectively. 

Assuming that the condensed phase is pure water, the value of xeq can be found by equating 
the chemical potential of pure condensed water with the chemical potential of its vapor in the 
gas solution.  Since the equations describing chemical potentials are non-linear and difficult to 
analyze, phase equilibrium is often described in terms of a thermodynamic function called 
fugacity.  The equality of chemical potentials can be replaced by equating the logarithms of the 
fugacity of pure condensed water with that of its vapor in the gas mixture solution.   The 
equation of solubility based on this concept is derived by Rabinovich [3] and can be expressed 
as follows: 

( )
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where, 

z
B
v

C
v

= + +1 2   , the compressibility of the gas mixture or the water vapor as required. 

=wsp  saturation pressure of water vapor at temperature T. 

vwcond =  the volume of the condensed water. 

The solubility equation can be solved for xeq by iteration.  For an ideal solution, xeqideal is equal 
to the ratio of the vapor pressure of the pure water, to the total pressure of the mixture.  The 
ratio of xeq / xeqideal is called the enhancement factor or excess solubility and has a value 
greater than 1.  The value of xeq is used to find the dew point temperature of a gas mixture, to 
determine the amount of condensation that occurs in a cooling process and to verify that the 
value of x input by the user does not exceed xeq. 

The thermodynamic properties (enthalpy, entropy and specific heat at constant pressure) can 
be determined from knowledge of the properties in the ideal gas state and the virial 
coefficients. 

The molar enthalpy of a moist gas mixture, hm, can be described by the equation:  

( ) ( ) ( ) ( )h x h h x h h x h h x h hm N N
o

N O O
o

O A A
o

A C C
o

C= + + + + + + +' ' ' +'  
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where, 

hi
o  = ideal gas molar enthalpy for gas i 

hi
'  = constant to adjust reference state for gas i 

 

The molar entropy of the moist gas mixture sm can be described by the equation: 
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where, 

si
o  = ideal gas molar entropy for gas i 

si
'  = constant to adjust reference state for gas i 

 

The molar specific heat at constant pressure of a moist gas mixture, cm, can be described by 
the equation: 
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where, 

ci
o  =  ideal gas molar specific heat at constant pressure for gas i. 

3.1 GAS PROPERTY DATABASE 

In order to use the equations presented in the previous section to calculate the thermodynamic 
properties, it is necessary to know the B and C virial coefficients of each of the pure gas 
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components and the mixed virial coefficients for all mixture combinations.  In addition, the ideal 
gas enthalpies, entropies and specific heats are required for each gas component.  Tables of 
compressibility data for the pure gases and the ideal gas enthalpies, entropies and specific 
heats are provided in reference [1].  B and C virial coefficients for the pure gases were 
obtained by using a least square fit of the compressibility function to isotherms at 10 degree 
increments from 180 ºK to 800 ºK and at 50 degree increments from 800 ºK to 2000 ºK. 

Mixed virial coefficients were calculated from molecular theory using the Leonard-Jones (6-12) 
potential model.  The following equations were used to calculate the virial coefficients based on 
the model: 

 ( ) ( ) ( )**33/2 TBNTB LJijAij σπ=  

  ( ) ( ) ( )**623/2 TCNTC LJiijAiij σπ=

  ( ) ( ) ( )**623/2 TCNTC LJijjAijj σπ=

where per mole (Avogadro’s number) N A = 6 02205 23. E

  or  or   T kT ij
* /= ε T kT iij

* /= ε T kT ijj
* /= ε

 k E= −1 3807 23.  J/K (Boltzmann constant) 

The equations and constants for calculating  and  are found in Hirshfelder, Curtis and 
Bird [4].  Values of potential parameters σ and ε/k for the pure gases were obtained by 
minimizing the errors in predicting the compressibility factors of the pure gases using the 
Leonard-Jones (6-12) potential.  Mixed potential parameters were obtained by means of the 
following semi-empirical mixing rules: 

BLj
* CLj

*

  ( )σ σ σ ξ12 11 22
1 60 5= + −. /

 ( ) ( ) ( )ε ε ε/ / /k k k12 11 22
2= ξ/  

 σ σ σ112 11 12
23=   

σ σ σ122 22 12
23=  

 ( ) ( ) ( )ε ε ε/ / /k k112 11 12
23= k  

 ( ) ( ) ( )ε ε ε/ / /k k122 22 12
23= k  
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(ξ ε ε= +1 0 892 3 211 22 11 22 11
3. / /*a t N A )π σ  when gas 1 is non-water and gas 2 is water 

or 

ξ = 10.  when both gases are non-water 

and 

a11  = polarizability of the apolar molecules 

t * . /= −8 0 5 3μ εσ  

μ =  dipole moment of the molecule 

Some of the mixed potential parameters between N2, Ar and CO2 with water were determined 
by Rabinovich [3] based on experimental data on the equilibrium fractional content of water 
vapor in the solvent gas.  Where available, these mixed potential parameters were used 
instead of the ones derived from the mixing rules. 

Based on the methods described, a database was developed containing all of the pure gas 
and mixed virial coefficients for the five gases at 10 degree increments from 180 °K to 800 °K 
and at 50 degree increments between 800 °K and 2000 °K.  A similar database was developed 
for the ideal gas enthalpies, entropies and specific heats. 

3.2 COMPUTATIONAL MODEL 

With most of the functions, the mixture’s pressure and temperature are known.  Since the virial 
coefficients are functions only of temperature, the database is used to calculate mixed 
coefficients Bgg, Bgw, Bww, Cggg, Cggw, Cgww and Cwww based on the formulas identified above at 
four temperatures surrounding the desired temperature.  Four point non-linear interpolation is 
used to calculate the mixed coefficients and their derivatives at the desired temperature. 
Since most of the properties require knowledge of the specific volume of the mixture, the virial 
equation of state is used iteratively to calculate the specific volume.  In cases where the 
temperature of the mixture is not known, iterative procedures are used to determine the 
temperature as well.  

3.3 TRANSPORT PROPERTIES 

Values for viscosity and thermal conductivity of individual gases at atmospheric pressure can 
be found in many references although there does not appear to be any definitive standard of 
accepted values as there are for steam and water.  We found the most complete coverage by 
Vasserman, Kazavchinskii, and Rabinovich [2] who have surveyed the available literature and 
presented tables of values over a range of temperatures and pressures.  We have used their 
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tabular values of viscosity and thermal conductivity as the basis of our database for Nitrogen, 
Oxygen, Argon and Carbon Dioxide.   

We have used the equations recommended by ASME [6] to compute the viscosity and thermal 
conductivity properties for water vapor.  These are the same equations used in our WinSteam 
product. 

There is little information available regarding the viscosity and conductivity of moist gases.  In 
most practical cases, the relatively small quantity of water vapor in gas mixtures has a small 
effect on the overall transport properties, unlike the thermodynamic properties, which are 
greatly affected by moisture.  Nonetheless, we have selected a method to account for the 
effects of moisture on viscosity based on kinetic theory as presented by Hirshfelder, Curtis and 
Bird [4]. 

3.3.1 Viscosity 
We treat the gas as a binary mixture between the non-polar gases (N2, O2, Ar and CO2) and 
water vapor.  For the non-polar gases, the viscosity of the mixture can be calculated as 
follows: 
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where, 

=iη  coefficient of viscosity of pure gas component i 
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=Tijij /,εσ  parameters in the potential function characteristic of 1-2 interaction 

=ix  mole fraction of component i 

 molecular weight of component i =iM

)*1,1()*2,2(* /ΩΩ=A  

=Ω )*,( ii integrals for calculating the transport coefficients for the Leonard-Jones (6-12) potential 

  

Once we have the viscosity of the non-polar gas mixture, we can use the equations for a 
polar/non-polar mixture.  The equation for viscosity of a binary mixture is as follows: 
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 =gη  viscosity of dry gas mixture at the specified temperature 

 =wη  viscosity of water vapor at the specified temperature 
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σ
η     and C1 = 266.93E-7 

 =gwσ  potential function parameter for mixture adjusted for one  polar molecule 

   weighted average molecular mass of the dry gas mixture =gM

To correct for pressure, we use the method of Chung et al. as described in Reid, Prausnitz and 
Poling [9] 

3.3.2 Thermal Conductivity 
In a similar manner, to calculate thermal conductivity we treat the gas as a binary mixture of 
the non-polar gases and water vapor. 

For the non-polar gas mixture, we use the Wassiljewa equation with the Mason and Saxena 
modification described by Reid, Prausnitz and Poling [9]. 
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The equation for thermal conductivity of the moist gases is as follows: 
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 =gλ  Thermal conductivity of dry gas mixture at the specified temperature 

 =wλ  Thermal conductivity of water vapor at the specified temperature 
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To correct for pressure, we use the Stiel and Thodos modification as described in Reid, 
Prausnitz and Poling [9]. 
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4 ACCURACY 

4.1 ACCURACY OF CALCULATIONS 

Thermodynamic properties for the pure gases calculated by DeskTop Gas have been checked 
against the values published by NBS [1] and ASME [6] for water vapor.  As shown on Tables 1 
through 20, the calculated values show excellent agreement with the source data throughout 
most of the valid range.  Some small differences can be observed at low temperatures and 
high pressures.  This is due to the limitations of using a third order virial equation of state.   

There is little published data on the properties of mixed gases.  One method to illustrate the 
accuracy of the mixing equations is to compare the results of DeskTop Gas to data for dry air, 
which is a mixture of Nitrogen, Oxygen, Argon and a small amount of Carbon Dioxide.  Tables 
21 through 24 show the comparison with air for the thermodynamic properties.   

As with the pure components, small errors can be observed at low temperatures and high 
pressures due to the limitations of the model.  The tables show some differences in enthalpy, 
entropy and specific heat occurring at 850 °K and growing with temperature.  This initially, was 
thought to be attributed to dissociation, but this was dismissed for two reasons.  First, 
dissociation effects were not included below 1500 °K in reference 1.  Second, the error is much 
greater than what can be attributed to dissociation above 1500 °K.   

Further examination of the data tables suggests that the tables in reference 1 are in error.  One 
would expect the thermodynamic properties to approach the ideal gas properties as the 
pressure is reduced to zero.  While this is the case for temperatures up to 800 °K, it is not the 
case above 800 °K.  Curiously, at 800 °K, the tables in reference 1 change from a temperature 
increment of 10 °K to 50 °K at the point where the error begins.  Perhaps this change of 
temperature increment was not handled properly.   

Comparison of data from Vasserman et al [2] in the temperature range from 850 °K to 1300 °K 
supports the conclusion that the tables from NBS [1] are in error.  Unfortunately, the tables 
from Vasserman  et al [2] do not contain data for temperatures above 1300 °K. 

Thermodynamic properties for moist air are presented by ASHRAE [10] at atmospheric 
pressure for temperatures up to 200 deg C.  The ASHRAE data is based on work done by 
Hyland and Wexler [8], who provide tables of calculated data at pressures up to 50 bar.  
Comparisons with this data are shown on Tables 29 through 40. 

Data for Viscosity and Thermal Conductivity is taken from Vasserman et al [2] for the pure 
gases except for water vapor which is taken from ASME [6].  Tables 41 and 42 show excellent 
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agreement with this data.  As with the thermodynamic properties, the accuracy of the mixing 
equations for the transport properties are illustrated by comparison with dry air.  These 
comparisons are shown in Table 43.  The mixing equations for the transport properties are not 
as precise as those for the thermodynamic properties; however, in most cases the errors are 
less than 1%.   

Some of the table data was generated using the @Gas functions for convenience.  They use 
the exact same function library as used in DeskTop Gas. 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 1 - COMPRESSIBILITY OF NITROGEN 

Temperature 
Range Pressure 

From To 0.01 atm 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.000% 0.000% 0.001% 0.006% 0.006% 0.022% 0.056% 0.101% 

260 300 0.000% 0.001% 0.001% 0.001% 0.005% 0.006% 0.011% 0.019% 

310 350 0.000% 0.000% 0.000% 0.001% 0.004% 0.006% 0.016% 0.020% 

360 400 0.000% 0.000% 0.000% 0.000% 0.001% 0.003% 0.005% 0.009% 

410 500 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.005% 0.009% 

510 600 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.007% 0.009% 

610 700 0.000% 0.000% 0.000% 0.000% 0.001% 0.001% 0.003% 0.005% 

710 800 0.000% 0.000% 0.000% 0.000% 0.001% 0.002% 0.002% 0.003% 

850 1450 0.000% 0.000% 0.000% 0.001% 0.003% 0.006% 0.007% 0.012% 

1500 2000 0.000% 0.000% 0.000% 0.000% 0.001% 0.002% 0.003% 0.006% 

  

 
COMPARISON OF RESULTS WITH NBS [1] DATA 

TABLE 2 - COMPRESSIBILITY OF OXYGEN 

Temperature 
Range 

Pressure 

From To 0.01 atm 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.000% 0.000% 0.004% 0.012% 0.008% 0.034% 0.112% 0.199% 

260 300 0.000% 0.000% 0.001% 0.001% 0.007% 0.008% 0.009% 0.021% 

310 350 0.000% 0.000% 0.000% 0.000% 0.005% 0.006% 0.009% 0.010% 

360 400 0.000% 0.000% 0.000% 0.000% 0.001% 0.002% 0.004% 0.006% 

410 500 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.004% 0.006% 

510 600 0.000% 0.000% 0.000% 0.001% 0.002% 0.002% 0.005% 0.006% 

610 700 0.000% 0.000% 0.000% 0.001% 0.001% 0.001% 0.001% 0.003% 

710 800 0.000% 0.000% 0.000% 0.000% 0.000% 0.001% 0.002% 0.004% 

850 1450 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.006% 0.008% 

1500 2000 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.002% 0.005% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 3 - COMPRESSIBILITY OF ARGON 

Temperature 
Range 

Pressure 

From To 0.01 atm 1 atm 10 atm 40 atm 

deg K Deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.000% 0.001% 0.001% 0.002% 0.004% 0.007% 0.071% 0.213% 

260 300 0.000% 0.000% 0.001% 0.001% 0.006% 0.007% 0.020% 0.030% 

310 350 0.000% 0.001% 0.001% 0.001% 0.003% 0.005% 0.014% 0.020% 

360 400 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.004% 0.012% 

410 500 0.000% 0.000% 0.000% 0.000% 0.001% 0.003% 0.008% 0.012% 

510 600 0.000% 0.000% 0.000% 0.001% 0.002% 0.002% 0.008% 0.013% 

610 700 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.005% 0.010% 

710 800 0.000% 0.000% 0.000% 0.001% 0.000% 0.001% 0.004% 0.007% 

850 1450 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 0.006% 0.011% 

1500 2000 0.000% 0.000% 0.000% 0.000% 0.001% 0.002% 0.002% 0.006% 

 
 

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 4 - COMPRESSIBILITY OF CARBON DIOXIDE 

Temperature 
Range 

Pressure 

From To 0.01 atm 1 atm 10 atm 40 atm 

deg K Deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

200 250 0.001% 0.001%  NA NA  NA  NA  NA  NA 
260 300 0.000% 0.001% 0.004% 0.005%  NA  NA  NA  NA 
310 350 0.000% 0.001% 0.003% 0.003%  NA  NA  NA  NA 
360 400 0.000% 0.001% 0.001% 0.002%  NA  NA  NA  NA 
410 500 0.000% 0.001% 0.001% 0.001%  NA  NA  NA  NA 
510 600 0.001% 0.001% 0.001% 0.001%  NA  NA  NA  NA 
610 700 0.001% 0.001% 0.001% 0.001%  NA  NA  NA  NA 
710 800 0.000% 0.000% 0.000% 0.001%  NA  NA  NA  NA 
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850 1450 0.000% 0.000% 0.005% 0.008%  NA  NA  NA  NA 
1500 2000 0.000% 0.000% 0.005% 0.006% 0.011% 0.028%  NA  NA 

  

   *NA indicates that CO2 is not in vapor state in this range.  

  

COMPARISON OF RESULTS WITH ASME [6] DATA 
TABLE 5 - COMPRESSIBILITY OF WATER VAPOR 

Temperature 
Range 

Pressure 

From To 0.01 atm 1 atm 10 atm 40 atm 

deg K Deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

290 350 0.001% 0.002%  NA  NA  NA  NA  NA  NA 
360 400 0.002% 0.002%  NA  NA  NA  NA  NA  NA 
410 500 0.002% 0.002% 0.002% 0.003%  NA  NA  NA  NA 
510 600 0.002% 0.002% 0.003% 0.003% 0.003% 0.003%  NA  NA 
610 700 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.005% 
710 800 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 
850 1450 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.004% 
1500 2000 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 0.002% 

  
  

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 6 - ENTHALPY OF NITROGEN 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.005% 0.022% 0.054% 0.221% 0.287% 1.235% 

260 300 0.001% 0.002% 0.004% 0.009% 0.031% 0.074% 

310 350 0.001% 0.001% 0.005% 0.006% 0.017% 0.024% 

360 400 0.001% 0.001% 0.006% 0.006% 0.022% 0.025% 

410 500 0.001% 0.001% 0.003% 0.005% 0.011% 0.019% 
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510 600 0.000% 0.001% 0.001% 0.005% 0.004% 0.007% 

610 700 0.001% 0.001% 0.002% 0.005% 0.009% 0.009% 

710 800 0.000% 0.001% 0.002% 0.002% 0.009% 0.010% 

810 1450 0.000% 0.000% 0.001% 0.001% 0.004% 0.006% 

1500 2000 0.000% 0.000% 0.002% 0.002% 0.008% 0.009% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 7 - ENTHALPY OF OXYGEN 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.005% 0.015% 0.041% 0.174% 0.287% 1.102% 

260 300 0.002% 0.002% 0.005% 0.010% 0.028% 0.062% 

310 350 0.001% 0.002% 0.009% 0.010% 0.018% 0.028% 

360 400 0.001% 0.002% 0.006% 0.007% 0.025% 0.026% 

410 500 0.001% 0.001% 0.003% 0.006% 0.010% 0.019% 

510 600 0.000% 0.001% 0.001% 0.002% 0.006% 0.011% 

610 700 0.000% 0.001% 0.002% 0.002% 0.007% 0.010% 

710 800 0.000% 0.001% 0.002% 0.002% 0.006% 0.010% 

810 1450 0.000% 0.001% 0.001% 0.001% 0.004% 0.007% 

1500 2000 0.000% 0.000% 0.002% 0.002% 0.008% 0.009% 

  
  

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 8 - ENTHALPY OF ARGON 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.049% 0.376% 0.082% 0.529% 0.075% 0.199% 

260 300 0.001% 0.002% 0.004% 0.007% 0.015% 0.032% 

310 350 0.002% 0.002% 0.008% 0.011% 0.038% 0.056% 

360 400 0.001% 0.002% 0.007% 0.010% 0.015% 0.033% 

410 500 0.001% 0.001% 0.002% 0.005% 0.012% 0.027% 

510 600 0.001% 0.001% 0.002% 0.003% 0.007% 0.015% 

610 700 0.000% 0.001% 0.003% 0.003% 0.013% 0.022% 

710 800 0.000% 0.001% 0.002% 0.003% 0.010% 0.018% 

810 1450 0.000% 0.000% 0.002% 0.004% 0.004% 0.007% 

1500 2000 0.000% 0.001% 0.002% 0.003% 0.012% 0.014% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 

TABLE 9 - ENTHALPY OF CARBON DIOXIDE 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250  NA  NA  NA  NA  NA  NA 

260 300 0.019% 0.030% 0.023% 0.057%  NA  NA 

310 350 0.014% 0.021% 0.049% 0.064% 0.389% 0.864% 

360 400 0.008% 0.011% 0.034% 0.041% 0.307% 0.436% 

410 500 0.008% 0.011% 0.019% 0.027% 0.099% 0.153% 

510 600 0.005% 0.009% 0.005% 0.010% 0.024% 0.064% 

610 700 0.006% 0.011% 0.007% 0.012% 0.025% 0.035% 

710 800 0.002% 0.003% 0.006% 0.012% 0.033% 0.037% 

810 1450 0.002% 0.004% 0.003% 0.007% 0.012% 0.028% 

1500 2000  **  **  **  **  **  ** 

** NBS data not available 

COMPARISON OF RESULTS WITH ASME [6] DATA 

TABLE 10 - ENTHALPY OF WATER VAPOR 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 290  NA  NA  NA  NA  NA  NA 

290 370  NA  NA  NA  NA  NA  NA 

380 450 0.013% 0.015%  NA  NA  NA  NA 

460 530 0.017% 0.018% 0.013% 0.024%  NA  NA 

540 600 0.021% 0.021% 0.026% 0.030% 0.006% 0.012% 

610 700 0.022% 0.023% 0.022% 0.023% 0.021% 0.024% 

710 800 0.026% 0.028% 0.026% 0.028% 0.026% 0.028% 

850 1450 0.047% 0.064% 0.047% 0.064% 0.048% 0.064% 

1500 2000 0.082% 0.093% 0.082% 0.093% 0.082 0.093% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 

TABLE 11 - ENTROPY OF NITROGEN 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.001% 0.003% 0.009% 0.037% 0.049% 0.208% 

260 300 0.000% 0.000% 0.001% 0.002% 0.006% 0.011% 

310 350 0.000% 0.000% 0.001% 0.001% 0.002% 0.003% 

360 400 0.000% 0.000% 0.001% 0.001% 0.003% 0.004% 

410 500 0.000% 0.000% 0.001% 0.001% 0.002% 0.003% 

510 600 0.000% 0.000% 0.000% 0.000% 0.001% 0.001% 

610 700 0.000% 0.000% 0.001% 0.001% 0.001% 0.002% 

710 800 0.000% 0.000% 0.000% 0.001% 0.001% 0.002% 

810 1450 0.000% 0.000% 0.000% 0.001% 0.001% 0.001% 

1500 2000 0.000% 0.000% 0.000% 0.000% 0.001% 0.001% 

 

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 12 - ENTROPY OF OXYGEN 

Temperature 
Range 

Pressure 

From To 1 Atm 10 Atm 40 Atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.005% 0.015% 0.041% 0.174% 0.287% 0.102% 

260 300 0.002% 0.002% 0.005% 0.010% 0.028% 0.062% 

310 350 0.001% 0.002% 0.009% 0.010% 0.018% 0.028% 

360 400 0.001% 0.002% 0.006% 0.007% 0.025% 0.026% 

410 500 0.001% 0.001% 0.003% 0.006% 0.010% 0.019% 

510 600 0.000% 0.001% 0.001% 0.002% 0.006% 0.011% 

610 700 0.000% 0.001% 0.002% 0.002% 0.007% 0.010% 

710 800 0.000% 0.001% 0.002% 0.002% 0.006% 0.010% 

810 1450 0.000% 0.001% 0.001% 0.001% 0.004% 0.007% 

1500 2000 0.000% 0.000% 0.002% 0.002% 0.003% 0.009% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 13 - ENTROPY OF ARGON 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.000% 0.001% 0.006% 0.022% 0.129% 1.102% 

260 300 0.000% 0.000% 0.000% 0.001% 0.005% 0.062% 

310 350 0.000% 0.000% 0.001% 0.001% 0.006% 0.028% 

360 400 0.000% 0.000% 0.001% 0.001% 0.004% 0.026% 

410 500 0.000% 0.000% 0.000% 0.001% 0.001% 0.019% 

510 600 0.000% 0.000% 0.000% 0.001% 0.001% 0.011% 

610 700 0.000% 0.001% 0.001% 0.001% 0.002% 0.010% 

710 800 0.000% 0.000% 0.001% 0.001%  **  ** 

810 1450 0.000% 0.000% 0.000% 0.001%  **  ** 

1500 2000 0.000% 0.000% 0.000% 0.000%  **  ** 

** NBS data not available  

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 14 - ENTROPY OF CARBON DIOXIDE 

 Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250  NA  NA  NA  NA  NA  NA 

260 300 0.002% 0.003% 0.006% 0.014%  NA  NA 

310 350 0.001% 0.003% 0.003% 0.005% 0.033% 0.086% 

360 400 0.002% 0.006% 0.006% 0.007% 0.038% 0.050% 

410 500 0.003% 0.004% 0.004% 0.006% 0.020% 0.025% 

510 600 0.003% 0.002% 0.002% 0.004% 0.010% 0.016% 

610 700 0.003% 0.001% 0.001% 0.003% 0.003% 0.006% 

710 800 0.003% 0.001% 0.001% 0.003% 0.001% 0.002% 

810 1450 0.002% 0.002% 0.002% 0.004% 0.003% 0.006% 

1500 2000  **  **  **  **  **  ** 
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COMPARISON OF RESULTS WITH ASME [6] DATA 
TABLE 15 – ENTROPY OF WATER VAPOR 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 290  NA  NA  NA  NA  NA  NA 

290 370  NA  NA  NA  NA  NA  NA 

380 450 0.017% 0.020%  NA  NA  NA  NA 

460 530 0.019% 0.020% 0.019% 0.030%  NA  NA 

540 600 0.021% 0.022% 0.028% 0.030% 0.013% 0.020% 

610 700 0.022% 0.022% 0.025% 0.025% 0.026% 0.028% 

710 800 0.023% 0.024% 0.026% 0.027% 0.029% 0.030% 

850 1450 0.033% 0.041% 0.037% 0.045% 0.040% 0.048% 

1500 2000 0.048% 0.052% 0.053% 0.058% 0.056 0.061% 

  
  

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 16 – SPECIFIC HEAT OF NITROGEN 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.062% 0.182% 0.758% 2.899% 2.923% 9.543% 

260 300 0.004% 0.005% 0.050% 0.057% 0.325% 0.368% 

310 350 0.002% 0.003% 0.014% 0.029% 0.123% 0.206% 

360 400 0.001% 0.002% 0.016% 0.022% 0.028% 0.053% 

410 500 0.002% 0.003% 0.026% 0.027% 0.076% 0.084% 

510 600 0.001% 0.003% 0.021% 0.024% 0.061% 0.076% 

610 700 0.001% 0.002% 0.014% 0.017% 0.029% 0.041% 

710 800 0.001% 0.001% 0.009% 0.011% 0.008% 0.015% 

810 1450 0.001% 0.002% 0.004% 0.007% 0.013% 0.022% 

1500 2000 0.001% 0.004% 0.006% 0.007% 0.005% 0.010% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 17 – SPECIFIC HEAT OF OXYGEN 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.043% 0.122% 0.466% 1.381% 2.495% 8.550% 

260 300 0.001% 0.002% 0.047% 0.055% 0.326% 0.386% 

310 350 0.001% 0.002% 0.011% 0.025% 0.111% 0.192% 

360 400 0.002% 0.004% 0.014% 0.020% 0.023% 0.042% 

410 500 0.002% 0.004% 0.020% 0.022% 0.062% 0.065% 

510 600 0.001% 0.002% 0.012% 0.017% 0.044% 0.059% 

610 700 0.001% 0.004% 0.004% 0.008% 0.015% 0.026% 

710 800 0.001% 0.001% 0.001% 0.003% 0.004% 0.009% 

810 1450 0.001% 0.001% 0.005% 0.008% 0.017% 0.029% 

1500 2000 0.000% 0.001% 0.003% 0.004% 0.011% 0.016% 

  

 
COMPARISON OF RESULTS WITH NBS [1] DATA 

TABLE 18 – SPECIFIC HEAT OF ARGON 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.031% 0.093% 0.517% 1.643% 1.574% 4.829% 

260 300 0.005% 0.007% 0.073% 0.096% 0.307% 0.575% 

310 350 0.001% 0.003% 0.014% 0.029% 0.259% 0.437% 

360 400 0.003% 0.004% 0.020% 0.026% 0.158% 0.355% 

410 500 0.003% 0.005% 0.026% 0.028% 0.095% 0.261% 

510 600 0.001% 0.003% 0.017% 0.022% 0.049% 0.068% 

610 700 0.001% 0.002% 0.007% 0.012% 0.023% 0.047% 

710 800 0.001% 0.002% 0.004% 0.008% 0.015% 0.022% 

810 1450 0.001% 0.002% 0.008% 0.014% 0.043% 0.066% 

1500 2000 0.001% 0.001% 0.001% 0.003% 0.023% 0.039% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 19 – SPECIFIC HEAT OF CARBON DIOXIDE 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250  NA  NA  NA  NA  NA  NA 

260 300 0.040% 0.052% 1.336% 4.255%  NA  NA 

310 350 0.029% 0.097% 0.167% 0.229% 4.022% 9.111% 

360 400 0.006% 0.008% 0.030% 0.052% 0.359% 0.849% 

410 500 0.004% 0.007% 0.065% 0.078% 0.184% 0.286% 

510 600 0.003% 0.007% 0.039% 0.051% 0.247% 0.328% 

610 700 0.004% 0.007% 0.013% 0.023% 0.114% 0.178% 

710 800 0.003% 0.007% 0.005% 0.017% 0.021% 0.043% 

810 1450 0.006% 0.013% 0.009% 0.016% 0.072% 0.206% 

1500 2000  **  **  **  **  **  ** 

** NBS data not available 

COMPARISON OF RESULTS WITH ASME [6] DATA 
TABLE 20 – SPECIFIC HEAT OF WATER VAPOR 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 290  NA  NA  NA  NA  NA  NA 

290 370  NA  NA  NA  NA  NA  NA 

380 450 0.102% 0.310%  NA  NA  NA  NA 

460 530 0.080% 0.155% 0.334% 0.778%  NA  NA 

540 600 0.065% 0.319% 0.414% 2.008% 0.731% 2.673% 

610 700 0.065% 0.080% 0.045% 0.075% 0.146% 0.302% 

710 800 0.093% 0.106% 0.093% 0.119% 0.087% 0.154% 

850 1450 0.148% 0.197% 0.146% 0.276% 0.190% 0.693% 

1500 2000 0.190% 0.218% 0.`90% 0.217% 0.189% 0.216% 
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COMPARISON OF RESULTS WITH NBS [1] DATA 

TABLE 21 - COMPRESSIBILITY OF DRY AIR 

Temperature 
Range 

Pressure 

From To 0.01 atm 1 atm 10 atm 40 atm 

Deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.001% 0.001% 0.001% 0.002% 0.018% 0.027% 0.124% 0.278% 

260 300 0.001% 0.001% 0.000% 0.001% 0.004% 0.007% 0.010% 0.014% 

310 350 0.001% 0.001% 0.000% 0.000% 0.002% 0.002% 0.010% 0.014% 

360 400 0.001% 0.001% 0.000% 0.001% 0.002% 0.003% 0.002% 0.003% 

410 500 0.001% 0.001% 0.000% 0.001% 0.002% 0.003% 0.009% 0.012% 

510 600 0.001% 0.001% 0.001% 0.001% 0.001% 0.002% 0.011% 0.012% 

610 700 0.001% 0.001% 0.001% 0.001% 0.000% 0.001% 0.007% 0.009% 

710 800 0.001% 0.001% 0.001% 0.002% 0.001% 0.002% 0.003% 0.005% 

810 1450 0.001% 0.001%  0.001% 0.002% 0.002% 0.003% 0.003% 0.005% 

1500 2000 0.0038 0.167% 0.005% 0.017% 0.005% 0.007% 0.004% 0.011% 

  

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 22 - ENTHALPY OF DRY AIR 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.004% 0.016% 0.031% 0.119% 0.125% 0.262% 

260 300 0.001% 0.002% 0.004% 0.009% 0.037% 0.070% 

310 350 0.001% 0.003% 0.005% 0.008% 0.007% 0.011% 

360 400 0.002% 0.005% 0.008% 0.009% 0.006% 0.009% 

410 500 0.001% 0.002% 0.005% 0.007% 0.005% 0.011% 

510 600 0.001% 0.002% 0.001% 0.003% 0.005% 0.007% 

610 700 0.001% 0.002% 0.001% 0.001% 0.007% 0.008% 

710 800 0.001% 0.004% 0.002% 0.004% 0.007% 0.010% 

810 1450 * 0.03% * 0.10% * 0.03% * 0.09% * 0.03% * 0.10% 

1500 2000 ** ** ** ** ** ** 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 23 - ENTROPY OF DRY AIR 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.002% 0.003% 0.006% 0.022% 0.020% 0.052% 

260 300 0.001% 0.002% 0.001% 0.002% 0.005% 0.006% 

310 350 0.003% 0.004% 0.001% 0.002% 0.006% 0.008% 

360 400 0.002% 0.004% 0.002% 0.004% 0.004% 0.007% 

410 500 0.001% 0.004% 0.001% 0.003% 0.003% 0.005% 

510 600 0.002% 0.004% 0.002% 0.004% 0.001% 0.003% 

610 700 0.002% 0.003% 0.002% 0.004% 0.001% 0.002% 

710 800 0.001% 0.003% 0.001% 0.003% 0.002% 0.003% 

850 1450 0.005% 0.014% 0.003% 0.005% 0.005% 0.009% 

1500 2000 ** ** ** ** ** ** 

COMPARISON OF RESULTS WITH NBS [1] DATA 
TABLE 24 - SPECIFIC HEAT OF DRY AIR 

Temperature 
Range 

Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.036% 0.098% 0.352% 1.026% 1.046% 3.162% 

260 300 0.004% 0.005% 0.049% 0.061% 0.294% 0.382% 

310 350 0.005% 0.007% 0.020% 0.034% 0.096% 0.170% 

360 400 0.001% 0.002% 0.004% 0.007% 0.016% 0.033% 

410 500 0.001% 0.003% 0.009% 0.012% 0.044% 0.056% 

510 600 0.002% 0.003% 0.005% 0.010% 0.028% 0.038% 

610 700 0.001% 0.003% 0.003% 0.007% 0.008% 0.022% 

710 800 0.001% 0.002% 0.005% 0.024% 0.012% 0.038% 

850 1450 * 0.47% * 1.40% * 0.48% * 1.38% * 0.50% * 1.40% 

1500 2000 ** ** ** ** ** ** 

Notes: *, ** - Questionable reference data 
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COMPARISON OF RESULTS WITH HYLAND & WEXLER [8] 
SATURATED HUMIDITY RATIO OF MOIST AIR 

(kg of Water Vapor/kg of Dry Air) 

TABLE 2 - Pressure = 1 bar 

Temp  deg C Hyland & Wexler @Air @Gas 
0 0.00384 .00834 .00834 

90 1.4833 1.4835 1.4833 

TABLE 26 - Pressure = 5 bar 

Temp  deg C Hyland & Wexler @Air @Gas 
0 0.000775 0.000777 0.000777 

90 0.10368 0.10375 0.10374 

100 0.16201 0.16207 0.16205 

150 13.041 12.989 12.989 

TABLE 27 - Pressure = 10 bar 

Temp  deg C Hyland & Wexler @Air @Gas 
0 0.000394 0.000396 0.000396 

90 0.04838 0.04844 0.04840 

100 0.07251 0.07258 0.07257 

150 0.5974 0.5069 0.5970 

160 1.0718 1.0708 1.0709 

170 2.5434 2.5400 2.5403 

TABLE 28 - Pressure = 50 bar 

Temp  deg C Hyland & Wexler @Air @Gas 
0 9.09E-5 9.25E-5 9.27E-5 

90 0.00985 0.00988 0.00989 

100 0.01430 0.01434 0.01435 

150 0.0736 0.0732 0.0733 

160 0.0993 0.0986 0.0987 

170 0.1336 0.1324 0.1325 

180 0.1796 0.1778 0.1779 

200 0.3306 0.3263 0.3263 
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COMPARISON OF RESULTS WITH HYLAND & WEXLER [8] 
SPECIFIC VOLUME OF SATURATED MOIST AIR 

(m3/kg of Dry Air) 

TABLE 29 - Pressure = 1 bar 

Temp Hyland & Wexler @Air @Gas 

Deg C Value Uncert Value Error Value Error 
0 0.78846 0.00010 0.78847 0.00001 0.78846 0.00000 

90 3.4974 0.00029 3.4973 -0.0001 3.4976 0.0002 

TABLE 30 - Pressure = 5 bar 

Temp Hyland & Wexler @Air @Gas 

Deg C Value Uncert Value Error Value Error 
0 0.15657 0.00011 0.15657 0.00000 0.15657 0.00000 

90 0.24273 0.00015 0.24270 -0.00003 0.24271 -0.00002 

100 0.26904 0.00020 0.26902 -0.00002 0.26902 -0.00002 

150 5.115 0.0063 5.117 0.002 5.116 0.001 

TABLE 31 - Pressure = 10 bar 

Temp Hyland & Wexler @Air @Gas 

Deg C Value Uncert Value Error Value Error 
0 0.078022 0.00015 0.078023 0.000001 0.078022 0.000000 

90 0.11226 0.00017 0.11225 -0.00001 0.11225 -0.00001 

100 0.11942 0.00022 0.11940 -0.00002 0.11940 -0.00002 

150 0.23281 0.00165 0.23289 0.00008 0.23288 0.00007 

160 0.32711 0.00120 0.32732 0.00021 0.32729 0.00018 

170 0.61489 0.00152 0.61553 0.00064 0.61547 0.00058 
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TABLE 32 - Pressure = 50 bar 

Temp Hyland & Wexler @Air @Gas 

deg C Value Uncert Value Error Value Error 
0 0.015331 0.00077 0.015324 -0.000007 0.015324 -0.000007 

90 0.021310 0.00050 0.021302 -0.000008 0.021301 -0.000009 

100 0.022073 0.00053 0.022066 -0.000007 0.022065 -0.000008 

150 0.02727 0.00186 0.02729 0.00002 0.02729 0.00002 

160 0.02885 0.00256 0.02888 0.00003 0.02888 0.00003 

170 0.03077 0.00346 0.03082 0.00005 0.03081 0.00004 

180 0.03315 0.00459 0.03323 0.00008 0.03323 0.00008 

200 0.0402 0.0076 0.0404 0.0012 0.0404 0.0002 

The differences in saturated humidity ratios between @Air or @Gas and Hyland & Wexler can 
be attributed mostly to the equations used to calculate the pressure of saturated vapor over 
liquid water.  @Air and @Gas use the latest equations provided by IAPWS  [7]. 

In the following comparisons, the properties calculated by @Air and @Gas use the saturated 
humidity ratio as calculated by Hyland & Wexler in order to show a comparison based on the 
same composition. 
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